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Safety Information
Read these instructions carefully and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this user guide or on the
equipment to warn of hazards or to call attention to information that clarifies or
simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning”
safety label indicates that an electrical hazard exists which
will result in personal injury if the instructions are not
followed.

This is the safety alert symbol. It is used to alert you to
personal injury hazards. Obey all safety messages that
follow this symbol to avoid possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in
death or serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result
in death or serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result
in minor or moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

NOTE: Provides additional information to clarify or simplify a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction,
installation, and operation of electrical equipment and has received safety training
to recognize and avoid the hazards involved.

Electrical equipment should be transported, stored, installed, and operated only in
the environment for which it is designed.
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Proposition 65 Notice
WARNING: This product can expose you to chemicals including lead and lead compounds,
which are known to the State of California to cause cancer and birth defects or other
reproductive harm. For more information go to www.P65Warnings.ca.gov.
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About the Book

Document Scope
The scope of this document is to provide a single reference for configuring and
connecting the TeSys T and the Allen-Bradley programmable logic controller
(PLC).

You do not need any other document to perform this task.

For more details about other capabilities of TeSys T motor management controller,
consult the related documents listed below.

Validity Note
The information described in this Quick Start Guide is valid for the hardware and
software used in the application example provided. The same procedures can be
used with different versions of the hardware and software given provided that
compatible versions are used.

Related Documents
Title of Documentation Description Reference

Number

TeSys T LTMR - Motor Management
Controller - User Guide

This is the main user guide that
introduces the complete TeSys T
range and describes the main
functions of the TeSys T LTMR motor
management controller and LTME
expansion module.

DOCA0127EN

TeSys T LTMR Motor Management
Controller - Installation Guide

This guide describes the installation,
commissioning, and maintenance of
the TeSys T LTMR motor
management controller and LTME
expansion module.

DOCA0128EN

TeSys T LTMR - Motor Management
Controller - Ethernet
Communication Guide

This guide describes the Ethernet
network protocol version of the TeSys
T LTMR motor management
controller.

DOCA0129EN

You can download these technical publications and other technical information
from our website at www.se.com.

You can download these technical publications and other technical information
from our website at www.se.com/ww/en/download/.

Presentation of the Application

Introduction
The application example helps you to define Direct On Line (D.O.L.) motor starter:
• for a 3-phase motor, class 10, 5.5 kW (7.5 hp) at 440 V, 50 Hz, rated current

In = 10.5 A, three-wire independent D.O.L.
• protected and controlled by an LTM R controller connected to a thrid-party

PLC over EtherNet/IP communication protocol
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Wiring Diagram

L Terminal strip control

O Off

N Network control

Logic Inputs of the LTM R Controller
The controller LTM R has 6 logic inputs:
• available via field wiring terminals I.1- I.6
• internally powered by the control voltage of the LTM R controller (the input

voltage is the same voltage as the controller supply voltage)
• isolated from the inputs of the LTM E expansion module

The 3 Common (C) terminals of the LTM R controller are connected to the A1
control voltage via an internal filter. For more information, refer to the TeSys T LTM
R Ethernet Modbus TCP/EtherNet IP User Manual.

NOTICE
LOGIC INPUTS DESTRUCTION HAZARD
• Connect the LTM R controller’s inputs using the 3 Common (C) terminals

connected to the A1 control voltage via an internal filter.
• Do not connect the Common (C) terminal to the A1 or A2 control voltage

inputs.
Failure to follow these instructions can result in equipment damage.

For more information, refer to the TeSys T LTM R Ethernet Modbus TCP/EtherNet
IP User Manual.
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Logic Inputs of the LTM E Expansion Module
The 4 logic inputs on the LTM E expansion module (I.7 - I.10) are not powered by
the control voltage of the LTM R controller.

For more information, refer to the TeSys T LTM R Ethernet Modbus TCP/EtherNet
IP User Manual.

Communication Architecture

Legend Commercial Reference Description

1, 2 LTMR27EBD LTM R controller communicating over Ethernet TCP / Modbus or EtherNet/IP

3 to 6 Allen-Bradley Programmable Logic Controller (PLC) from Rockwell Automation

3 1756-A4 Allen-Bradley ControlLogix chassis with 4 slots

4 1756-PA72 Allen-Bradley ControlLogix power supply 120...240 V AC (5 V/10 A)

5 1756-L655 Allen-Bradley ControlLogix Logix55655 controller, revision 16

6 1756-ENBT Allen-Bradley ControlLogix EtherNet/IP primary scanner: network card for the PLC to
exchange information between TeSys T and the PLC

Software Tools
The following software tools must be used for this application. Their use requires a
basic knowledge.

Commercial Reference Freeware Description

9357-ENETL3 – RSNetWorx for EtherNet/IP application for
configuring and monitoring EtherNet/IP networks and
configuring connected devices.

9324-RLD300ENE – RSLogix Designer configuring and programming
software for the Allen-Bradley Logix5000 family of
controller.

– SE TeSys T MMC L EIP ATeSys® T Motor Management Controller system
without an expansion module, configurable via the
HMI port. The variant enables you to preserve your
local configuration.

– SE TeSys T MMC L EV40 EIP ATeSys® T Motor Management Controller system
with expansion module, configurable via the HMI
port. The variant enables you to preserve your local
configuration
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Commercial Reference Freeware Description

– SE TeSys T MMC R EIP ATeSys® T Motor Management Controller system
without expansion module configurable via the
network.

– SE TeSys T MMC R EV40 EIP ATeSys® T Motor Management Controller system
with expansion module configurable via the network.

In local configuration mode, the parameter Config via Network Port Enable
must be disabled. This mode preserves the local configuration made using the
Magelis® XBTor SoMove through the HMI port and blocks PLC configuration via
the network.

In remote configuration mode, the parameter Config via Network Port Enable
must be enabled. This enables the PLC to remotely configure the LTM R
controller.

NOTE: In remote mode, the parameters overwritten by the PLC will be lost.
This mode is useful when replacing inoperable devices.

The Config via Network Port Enable parameter is set by default.

Ethernet Network
Protocol: EtherNet/IP is an application layer protocol treating devices on the
network as a series of objects. It is an implementation of the common industrial
protocol (CIP) over TCP/IP.

The network carries control data and the properties of the device being controlled.
It enables you to operate either in a client/server mode or a peer-to-peer mode.

Two main types of messages can be exchanged:
• Implicit messaging, dedicated to fast exchanges of process data.
• Explicit messaging, dedicated to slower exchanges such as configuration,

settings, or diagnostics data.

Fallback Strategy Configuration for the TeSys T on the EtherNet/
IP Network

When communication between the LTM R controller and either the network or the
HMI is lost, the LTM R controller is in a fallback condition. The behavior of logic
outputs O.1 and O.2 following a communication loss is determined by:
• the operating mode and
• the Network Port Fallback Setting and HMI Port Fallback Setting Parameters.

Fallback setting selection can include:

Port Fallback Setting Description

Hold (O.1, O.2) Directs the LTM R controller to hold the state of logic outputs O.1 and O.2 as of the time of the
communication loss.

Run Directs the LTM R controller to perform a Run command for a 2-step control sequence on the
communication loss.

O.1, O.2 Off Directs the LTM R controller to turn off both logic outputs O.1 and O.2 following a communication
loss.

O.1, O.2 On Directs the LTM R controller to turn on both logic outputs O.1 and O.2 following a communication
loss.

O.1 On Directs the LTM R controller to turn on only logic output O.1 following a communication loss.

O.2 On Directs the LTM R controller to turn on only logic output O.2 following a communication loss.

The following table indicates which fallback options are available for each
operating mode:
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Port Fallback Setting Operating Mode

Overload Independent Reverser 2-step 2-speed Custom

Hold (O.1, O.2) Yes Yes Yes Yes Yes Yes

Run NO NO NO Yes No No

O.1, O.2 Off Yes Yes Yes Yes Yes Yes

O.1, O.2 On Yes Yes NO NO NO Yes

O.1 On Yes Yes Yes NO Yes Yes

O.2 On Yes Yes Yes NO Yes Yes

NOTE:When you select a network or HMI fallback setting, your selection must
identify an active control source.

Setting up TeSys T

LTM R Settings with DTM
SoMove software is a Microsoft® Windows®-based application, using the open
FDT/DTM technology. SoMove contains DTMs for different devices. The TeSys T
DTM is a specific DTM that enables the configuration, monitoring, control, and
customization of the control functions of the LTM R controller, as part of the TeSys
T motor management system. For TeSys T EtherNet/IP you will need at least DTM
version 2.8.x.x.

The TeSys T DTM can be used to:
• Configure parameters for the LTM R controller
• Display information about the LTM R controller configuration and operation
• Display the status of trips and alarms in the LTM R controller
• Control the motor
• Customize operating modes

The quick start guide introduces the protection and network settings to define to
start your TeSys T. For more information refer to TeSys T DTM for SoMove FDT
Container Online Help embedded in the DTM software.

Protection Settings
The table shows the steps to set the protection settings:

Step Action

1 Connect the device to the DTM and make sure that the TeSys T is in configuration mode.

2 Select the Device > command > enter configuration.

3 Selectmain settings in the parameter list tab.
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Step Action

4 Set the configuration as follows:
• motor operating mode: independent 3 wire
• motor nominal voltage: 440 V
• motor nominal power: 5.5 kW
• motor full load current: 10.53 A

5 Select the Device > command > exit configuration to exit protection settings.

Network Settings
The table shows the steps to set the network settings:

Step Action

1 Connect the device to the DTM and make sure that the TeSys T is in configuration mode.

2 Select the Device > command > enter configuration.

3 Selectmain settings in the communication tab.
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Step Action

4 Set the configuration as follows:
• Ethernet IP address setting: expected
• Ethernet subnet mask setting: set according to Ethernet network
• Network Protocol: EtherNet/IP

5 Select the Device > command > exit configuration to exit network settings.

6 Make sure to perform a power cycle of the device after the network setting.

Setting up Communication Network to a PLC

Introduction
This chapter describes step by step how to set the EtherNet/IP communication
including the TeSys T motor starters and an Allen-Bradley PLC using:
• RSNetWorx for EtherNet/IP configuration software for network configuration,

and
• RSLogix 5000 for PLC configuration.

Prerequisite
Before you start configuring the application, RSLinx, RSNetWorx for EtherNet/IP,
and RSLogix 5000 software from Rockwell Automation must be
• correctly installed on your computer,
• activated, and
• correctly configured to communicate with the PLC.
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Configuration Process

1) Downloading the EDS Files
The following table describes the steps to follow to download the EDS files
associated with TeSys T from the www.se.com website:

Step Action

1 Open the Schneider Electric website: www.se.com.

2 Type TeSys T in the Search field.

3 In the Product Ranges section, click TeSys T.

4 Click the Downloads tab, and then Software/Firmware.

5 Select EDS file for TeSys T EIP and download the EIP_EDS 1.1.10 file on your hard disk.

Select for both TeSysT SE TeSysT MMC R EIP file.

6 Extract the EIP_EDS 1.1.10 file into a single directory to your hard disk.

2) Registering the EDS Files using RSNetWorx for EtherNet/IP
To register the starter-controller’s EDS in the EDS library of RSNetWorx for
EtherNet/IP software, follow the procedure below:

Step Action Result

1 Start RSNetWorx for EtherNet/IP.

2 Select the menu command Tools > EDS Wizard... TheWizard welcome screen opens.

3 Click Next. The Options screen opens.

4 Select Register an EDS file(s) and click Next. The Registration screen opens.

5 Select Register a directory of EDS files and browse to the
directory in which you unzipped the EDS files.

6 Click Next. The EDS File Installation Test Results screen opens.
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Step Action Result

7 Click Next. The Change Graphic Image screen opens. The 4 TeSys T
are listed in the Product Types field as motor starters.

8 Click Next. The Final Task Summary screen opens.

9 Verify that the devices have been registered and click Next. The completion screen opens.

10 Click Finish. The EDS Wizard closes.

You can find the EDS recorded into the hardware library under
EtherNet/IP > Vendor > Schneider Automation, Inc. >
Motor Starter

3) Viewing the Devices on the EtherNet/IP Network in Online Mode
using RSNetWorx for EtherNet/IP

The process for viewing the devices on the EtherNet/IP network in online mode
using RSNetWorx for EtherNet/IP software is described below:

Step Action

1 Connect the appropriate programming cable from your PC to the Allen-Bradley PLC.

2 Connect each device to the network.

3 From RSNetWorx for EtherNet/IP software, select the menu command Network > Online.

Result: The Browsing Network dialog box opens as the system discovers devices present on the network.

4 Result:When the Browsing Network dialog box finishes, the physically connected devices appear in the configuration
view including the TeSys T. The IP addresses appear below each icon.
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4) Configuring the PLC using RSLogix 5000
The process for configuring the PLC using RSLogix 5000 software is described
below:

Step Action

1 Start RSLogix 5000 software.

2 Create a project by selecting the command File > New.

Result: The New Controller dialog box opens.

3 Set the characteristics of the controller used in the application example:
• Type: 1756-L55 Controller ControlLogix5555
• Revision: 16
• Name: Enter a controller name, for example TeSys_T_application. The name is used to create the project file; the .acd

extension is automatically appended to this name.
• Chassis Type: 1756-A4 4-Slot ControlLogix Chassis
• Slot: 0, which is the slot number for this controller.

NOTE: In ControlLogix, controllers occupy a numbered slot in the chassis and can be placed in any slot. It is also
possible to place multiple controllers in the same chassis.

• Create in: Enter the directory in which you want to store the project file.

4 Click OK to confirm the selected settings and to create the project.
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Step Action

5 Right-click I/O Configuration > 1756 Backplane, 1756-A4 in the main screen to add the EtherNet/IP primary.

Result: The Select Module dialog box opens.

6 Expand the Communications tree in the Select Module dialog box, and then select the EtherNet/IP communication
module.

The figure shows 1756-ENBT as the EtherNet/IP communication module as an example:
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Step Action

7 Select theMajor Revision for the EtherNet/IP communication module used in the application, and then click OK to confirm
the major revision.

Result: The New Module dialog box opens.

8 Set the characteristics of the Ethernet/IP communication module used in the application example:
• Name: EIP_master
• Slot: 2, which is the slot number for this Ethernet/IP communication module.

NOTE: In ControlLogix, controllers occupy a numbered slot in the chassis and can be placed in any slot. It is also
possible to place multiple communication cards in the same chassis.

• Major Revision: 4, which was confirmed in the Select Major Revision dialog box.
• Minor Revision: 1
• IPAddress: 192.168.1.55

9 Click OK to confirm the selected settings.

Result: TheModule Properties dialog box opens.
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Step Action

10 Click OK to confirm the addition of communication module.

11 The Ethernet/IP Communication module is displayed under I/O Configuration on the main screen.
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Step Action

12 Right-click I/O Configuration > 1756 Backplane, 1756-A4 > [2] 1756-EBNT/A EIP_master in the main screen to add the
TeSys T module.

Result: The Select Module dialog box opens.

13 Expand the Communications tree in the Select Module dialog box, and then select ETHERNET-MODULE Generic
Ethernet Module.
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Step Action

14 Click OK to confirm the Ethernet module.

Result: The New Module dialog box opens.

15 Set the characteristics of the Generic Ethernet module communication module used in the application example:
• Name: TeSys_T_example1
• Comm Format: Data-INT
• IPAddress: 192.168.1.35
• Input Assembly Instance: 116
• Input size: 64
• Output Assembly Instance: 106
• Output size: 5
• Configuration Assembly Instance: 6
• Configuration size: 0

NOTE: The TeSys T supports several different input and output assemblies. Refer to the TeSys T LTM R Ethernet
Modbus TCP/IP User Manual.

16 Click OK to confirm the selected settings.

Result: TheModule Properties dialog box opens.

17 Click OK to confirm the addition of communication module.
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Step Action

18 The TeSys T module is displayed under I/O Configuration on the main screen.

19 In the standard toolbar, click Communication > Select Recent Path.

Result: The Select Recent Communications Path dialog box opens, from which you can choose a communications path
from among the most recent paths stored on the PC.

5) Transferring the Configuration to the PLC using RSLogix 5000
The process for monitoring the controller’s tags and values assigned to them
using RSLogix 5000 software is described below:

Step Action

1 Turn the key located on the front of the PLC processor to the PROG position.

2 In RSLogix 5000 software, set the operational mode to Offline.

3 Select the menu command Communications > Download.

Result: The Download dialog box opens.
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Step Action

4 Confirm the download by clicking button Download when prompted in the dialog box.

Result: A message indicates that the download is complete, in the results window at bottom of the screen.

5 Switch the controller to Run mode: turn the key to the RUN position on the front of the PLC processor. The RUN LED of the
PLC processor turns green on and the program is launched.

6) Performing Functional Testing of the Communication Network
Including Allen-Bradley PLC and TeSys T Products

Step Action

1 In the RSLogix 5000 Controller Organizer, select Controller Tesys_T_application > Controller Tags, and then right-click
Monitor Tags.

Result: The Controller Tags window appears.

2 Select the Monitor Tags tab at the bottom of the Controller Tags window.

3 Expand the tag name TeSys_T_example1:1 > TeSys_T_example1:I.Data > TeSys_T_example1:I:Data[4] to view the
values assigned to the tags.

4 Name the topological addresses in such a way to avoid programming with names which do not provide any information of
the contents of the memory location. Refer to the user’s manuals TeSys T LULC09 DeviceNet Communication Module and
TeSys T Communication Variables for details.

In the application example, the following tags names are used for Motor 1):

Instance 100: LTM R Control Registers

This assembly contains several control registers commonly used with an LTM R
controller.

DOCA0119EN-02 23
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Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5

path: 6C : 01 : 05

(Register 704)

path: 6C : 01 : 04

(Register 703)

path: 6C : 01 : 01

(Register 700)

LSB (least significant bit) MSB (most significant bit) LSB MSB LSB MSB

Instance 106: EIOS_TeSys T Output

This assembly is vendor specific. All registers are in little endian.

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5

path: 6C : 01 : 01

(Register 700)

path: 6C : 01 : 02

Reserved (value = 0)

path: 6C : 01 : 03

Reserved (value = 0)

Byte 6 Byte 7 Byte 8 Byte 9

path: 6C : 01 : 04

Reserved (value = 0)

path: 6C : 01 : 05

(Register 704)

Instance 110: LTM R Monitoring Registers (with dynamic configuration)

This assembly contains several monitoring registers commonly used with an LTM
R controller. You can choose registers by setting 1-3 attributes of TeSys T
Monitoring Control Object. For more information, refer to TeSys T LTM R Ethernet
Modbus TCP/IP User Manual.

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7

Register pointed using path: C6
: 01 : 05

Register pointed using path: C6 :
01 : 06

Register pointed using path: C6
: 01 : 07

Register pointed using path: C6
: 01 : 08

LSB MSB LSB MSB LSB MSB LSB MSB

Instance 116: EIOS_TeSys T Input

This assembly is vendor specific. All registers are in little endian.

Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6 Byte 7

path: 68 : 01 : 02

(Register 451)

path: 68 : 01 : 03

(Register 452)

path: 68 : 01 : 04

(Register 453)

path: 68 : 01 : 05

(Register 454)

Byte 8 Byte 9 Byte 10 Byte 11 Byte 12 Byte 13 Byte 14 Byte 15

path: 68 : 01 : 06

(Register 455)

path: 68 : 01 : 07

(Register 456)

path: 68 : 01 : 08

(Register 457)

path: 68 : 01 : 09

(Register 458)

Byte 16 Byte 17 Byte 18 Byte 19 Byte 20 Byte 21 Byte 22 Byte 23

path: 68 : 01 : 0A

(Register 459)

path: 68 : 01 : 0B

(Register 460)

path: 68 : 01 : 0C

(Register 461)

path: 68 : 01 : 0D

(Register 462)

Byte 24 Byte 25 Byte 26 Byte 27 Byte 28 Byte 29 Byte 30 Byte 31

path: 68 : 01 : 0E

(Register 463)

path: 68 : 01 : 0F

(Register 464)

path: 68 : 01 : 10

(Register 465)

path: 68 : 01 : 11

(Register 466)

Byte 32 Byte 33 Byte 34 Byte 35 Byte 36 Byte 37 Byte 38 Byte 39

path: 68 : 01 : 12

(Register 467)

path: 68 : 01 : 13

(Register 468)

path: 68 : 01 : 14

(Register 469)

path: 68 : 01 : 15

(Register 470)
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Byte 40 Byte 41 Byte 42 Byte 43 Byte 44 Byte 45 Byte 46 Byte 47

path: 68 : 01 : 16

(Register 471)

path: 68 : 01 : 17

(Register 472)

path: 68 : 01 : 18

(Register 473)

path: 68 : 01 : 19

(Register 474)

Byte 48 Byte 49 Byte 50 Byte 51 Byte 52 Byte 53 Byte 54 Byte 55

path: 68 : 01 : 1A

(Register 475)

path: 68 : 01 : 1B

(Register 476)

path: 68 : 01 : 1C

(Register 477)

path: 68 : 01 : 1D

(Register 478)

Byte 56 Byte 57 Byte 58 Byte 59 Byte 60 Byte 61 Byte 62 Byte 63

path: 68 : 01 : 1E

(Register 479)

path: 68 : 01 : 1F

(Register 480)

path: 68 : 01 : 20

(Register 481)

path: 68 : 01 : 21

(Register 482)

Byte 64 Byte 65 Byte 66 Byte 67 Byte 68 Byte 69 Byte 70 Byte 71

path: 68 : 01 : 22

(Register 483)

path: 68 : 01 : 23

(Register 484)

path: 68 : 01 : 24

(Register 485)

path: 68 : 01 : 25

(Register 486)

Byte 72 Byte 73 Byte 74 Byte 75 Byte 76 Byte 77 Byte 78 Byte 79

path: 68 : 01 : 26

(Register 487)

path: 68 : 01 : 27

(Register 488)

path: 68 : 01 : 28

(Register 489)

path: 68 : 01 : 29

(Register 490)

Byte 80 Byte 81 Byte 82 Byte 83 Byte 84 Byte 85 Byte 86 Byte 87

path: 68 : 01 : 2A

(Register 491)

path: 68 : 01 : 2B

(Register 492)

path: 68 : 01 : 2C

(Register 493)

path: 68 : 01 : 2D

(Register 494)

Byte 88 Byte 89 Byte 90 Byte 91 Byte 92 Byte 93 Byte 94 Byte 95

path: 68 : 01 : 2E

(Register 495)

path: 68 : 01 : 2F

(Register 496)

path: 68 : 01 : 30

(Register 497)

path: 68 : 01 : 31

(Register 498)

Byte 96 Byte 97 Byte 98 Byte 99 Byte 100 Byte 101 Byte 102 Byte 103

path: 68 : 01 : 32

(Register 499)

path: 68 : 01 : 33

(Register 500)

path: 68 : 01 : 34

(Register 501)

path: 68 : 01 : 35

(Register 502)

Byte 104 Byte 105 Byte 106 Byte 107 Byte 108 Byte 109 Byte 110 Byte 111

path: 68 : 01 : 36

(Register 503)

path: 68 : 01 : 37

(Register 504)

path: 68 : 01 : 38

(Register 505)

path: 68 : 01 : 39

(Register 506)

Byte 112 Byte 113 Byte 114 Byte 115 Byte 116 Byte 117 Byte 118 Byte 119

path: 68 : 01 : 3A

(Register 507)

path: 68 : 01 : 3B

(Register 508)

path: 68 : 01 : 3C

(Register 509)

path: 68 : 01 : 3D

(Register 510)

Byte 120 Byte 121 Byte 122 Byte 123 Byte 124 Byte 125 Byte 126 Byte 127

path: 68 : 01 : 3E

(Register 511)

path: 68 : 01 : 3F

(Register 512)

path: 68 : 01 : 40

(Register 513)

path: 68 : 01 : 41

(Register 514)
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